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Purpose 
 
This guide is intended to assist in the initial installation and proactive maintenance of your of 
your RightNow CX implementation.  Adherence to the guidelines laid out in this document 
will help to ensure optimal performance and stability of your RightNow deployment. 
 
Product architecture, network requirements, workstations configuration requirements, 
installation methodologies, network maintenance, and workstation troubleshooting are each 
covered herein.  Please see our knowledge base at http://crm.rightnow.com for updates in 
each of these areas.  
 
 
 
RightNow Architecture 
 
The RightNow application is a rich Internet application utilizing a standard 3-Tier 
architecture consisting of the following: 
 
Smart Client Tier: The client tier consists of a .NET Smart Client application that presents 
content received from the application tier. The client tier communicates with the application 
tier through the Internet via Hypertext Transfer Protocol (HTTP) or Hypertext Transfer 
Protocol with Secure Socket Layer (HTTPS). 
 
Application Tier: The application tier provides the business logic for the RightNow product 
and communicates data from the database tier to the client tier. This tier resides on web 
server farms located in RightNow data center facilities. 
 
Database Tier: At the base of the application is the database tier, consisting of the database 
management system that manages the database containing the data users create, delete, 
modify, and query. 
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Networking Requirements and Recommendations 
 
As the RightNow application is web services based, the corporate network plays an important 
role in the efficient and consistent connectivity to the application. The following items should 
be considered when implementing the RightNow solution: 
 
 
Bandwidth: For satisfactory performance, a high-speed Internet connection is required. Dial-
up connections are not supported. The information below provides guidelines for the network 
bandwidth to the Internet. 
 
As a recommended minimum, a 512kbps (kilobits per second) Internet connection must be 
available. 
 
Data payloads of the application differ greatly depending upon the implementation. Data 
requests and responses are also directly related to agent activity types and usage. Gross 
averages show application request payloads to range from 1-50KB each, with maximums 
reaching 100KB - 2MB. Transaction times will be directly proportional to the bandwidth 
available to the application. Single agent utilization may average 1-10kbps in five minute 
intervals, but may burst well beyond this in shorter intervals.  
 
Regular bandwidth utilization monitoring should be done in production environments to 
facilitate the tuning of the amount of bandwidth provisioned and its optimal utilization. 
 
If your network utilizes a private WAN (typically over multiple call centers) specified 
bandwidth must be available throughout the entire network path; that is from the Internet to 
the Private WAN to the LAN and to the Agent workstation. 
 
 
Round Trip Time:  Your network connectivity to the RightNow data center (either Internet 
or private WAN) must consistently provide less than a 300ms round trip time (RTT) and less 
than 1% packet-loss. Where possible, your IT/IS staff should work to minimize WAN / 
Internet latency to ensure proper application performance. 
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Network Appliances (including Proxy Devices, Firewalls, and Content Filters):   
The customer network administration team must ensure that all communication between the 
RightNow client application and the RightNow hosted server is allowed, in an unrestricted 
manner, through all levels of the customer network.  All network appliances must be 
configured to allow all traffic between the client workstations and the following domains to 
occur in an unrestricted manner: 

*.custhelp.com 
*.rightnowtech.com 
*.rightnow.com 
*.rnttraining.com 
*.livelook.com and *.livelook.net (for co-browse functionality) 
*.birst.com (for Enterprise Analytics functionality) 
*.hivelive.com (for RightNow Social functionality) 
 

Applicable network appliances include the following (but are not limited to): 
 

Gateways 
Routers 
Hubs 
Bridges 
Switches 
Proxy Servers 
Firewalls 
Load Balancers 

 
Proxy servers must be configured with authentication and caching exclusion rules for each of 
the domains listed above. Installation will not occur successfully when Proxy authentication 
other than NTLM is in place. 
 
Firewalls must be configured to allow traffic on HTTP port 80 and HTTPS port 443 for the 
domains listed above. 
 
Customers using HTTP / IP proxy devices, either directly or indirectly, must ensure that 
these devices are configured to exclude RightNow application traffic from any caching 
operations. These devices include but are not limited to:  
 

 Traditional proxy server (PC server or dedicated appliances) 
 Content caching/acceleration devices 
 Local content filtering/inspection appliances 
 Hosted content filtering and inspection services 
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Quality of Service (QoS) Packet-Shaping Policies: If your networks have QoS / packet-
shaping policies implemented, the RightNow application should be considered a 
performance-sensitive application and accordingly given appropriate priority to ensure 
maximum performance.  
 
If your organization has not instituted QoS/packet-shaping policies, you should consider the 
economic advantages of grooming network traffic to provide priority applications, such as 
your RightNow application, sufficient access to network resources. Whenever possible, 
customer LAN / WAN connectivity should be groomed to match generally-accepted VOIP 
standards:  
 

 Less than 250ms round trip time (RTT),  
 Less than 5% latency jitter,  
 Near-zero packet-loss, and  
 Appropriate / consistent Layer-2/3 QoS policing. 

 
 
Wide Area Network / Internet Load Balancing 
 
Wide area network (WAN) and internet load balancing must be performed in a per-session 
vs. a per-packet manner for RightNow traffic.  Per-packet load balancing often leads to out of 
order packet delivery which will result degraded performance of your RightNow application 
and may result in its decreased stability. 
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Workstation Requirements and Recommendations 
 
The RightNow solution consists of a .NET Smart Client application that is automatically 
installed and updated from the RightNow site.  In addition, the Management and 
Configuration portions of the application require the Microsoft Internet Explorer Web 
Browser.  The following items are recommended to maximize application performance.  
These are listed in addition to the workstation requirements published on the RightNow 
support website. 
 
Hardware Configuration: The minimum hardware recommendations for the staff member 
workstation listed in Table 1 are for RightNow applications. These recommendations do not 
include the additional disk space required for operating system swap space (refer to the 
operating system documentation) or other applications simultaneously running on the 
workstation. 
 

Table 1:  Table 1: Workstation Hardware Requirements 

Workstation Type Memory CPU Hard Disk 

Agent Minimum: 512 MB1 
Recommended: 1 GB 

Minimum: 1 GHz 
Recommended: 1.5 
GHz or greater 

x86—850 MB free  

x64—2 GB free 

512 MB virtual memory2 

Administrator Minimum: 1 GB 
Recommended: 2 GB  
 

1.5 GHz or greater x86—850 MB free  

x64—2 GB free 

512 MB virtual memory2 

1– Minimum memory for Windows Vista and Windows 7 is 1 GB. 

2 – For Terminal Server users, the hard disk space must be available on the server for use by the client. 

 
Operating Systems: Supported operating systems are listed in RightNow answer 31.  
 
http://crm.rightnow.com/app/answers/detail/a_id/31 
 
Select the link for the appropriate version. Note that newer versions of RightNow have 
deprecated support for older operating systems. 
 
 
Workstation Display Settings: To view RightNow windows, consoles, and panels, you 
must configure the display properties of your workstation to display a minimum screen area 
of 1024 by 768 pixels with the “small fonts” or “normal size” (96 dpi). 
 
.NET Framework: RightNow staff and administrator workstations require and must support 
.NET Framework Version 4.0. If a staff or administrator workstation does not have .NET 
Framework Version 4.0 installed, the component manager will prompt you to download and 
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install it. (This requirement does not apply to the Accessibility Interface.) 

 
 
Web Browsers: The RightNow solution requires a PC version of Microsoft Internet 
Explorer.  Such users must have Internet Explorer set as their default browser.  Table 3 
shows Internet Explorer version requirements. For end-user web browser recommendations, 
refer to Answer ID 31 at http://rightnow.custhelp.com. Note that improved memory handling 
capabilities of Internet Explorer 8 make it the preferred version for the latest versions of 
RightNow. 
 

Table 3: Internet Explorer Version Requirements 
 

Internet Explorer 
Version 

7.0, 8.0, or 9.0 

 
Additional Requirements: If you are using RightNow Live or RightNow Sales, refer to 
Table 5 for software and hardware requirements. These requirements are in addition to the 
workstation recommendations listed above. 
 

Table 5: Additional Requirements 
 

User Additional Requirements 

Sales Quotes Staff Member Microsoft Word 2007, or 2010 (merging quotes 
only) 

Sales Outlook Integration Microsoft Outlook 2007, or 2010 
RightNow Chat with co-
browse 

Java Runtime Environment (JRE) 1.6.0 build 
24 or newer 

Customer Portal Adobe Dreamweaver CS4 and CS5 
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 Workstation Settings (Required for RightNow Administrators Only): Several settings 
are marked for troubleshooting only. 
 

1. Verify Browser Encoding Settings:  Internet Explorer > View > Encoding 
 
o Auto-select – Not selected 
o Western European ISO – Selected 

 
2. Verify correct browser caching: Start > Control Panel > Internet Options > General 

Tab > Settings Button 
 
o Check for newer versions of stored pages – Every visit to the page 

 
3. Verify Browser Security Settings: Start > Control Panel > Internet Options > Security 

Tab > Internet (Globe Icon) Selected OR Trusted Sites Zone > Custom Level Button 
 
o .Net Reliant Framework 

 Run components not signed with Authenticode – Prompt 
 (Required) Run components signed with Authenticode – Enable 

 
o Downloads 

 File Download – Enable 
 

o Miscellaneous 
 Access data sources across domains – Prompt or Enable 
 Allow scripting of Internet Explorer web browser control – Enable 
 Allow Web pages to use restricted protocols for active content – Enable or 

Prompt 
 Allow script-initiated windows without size or position constraints – Enable 
 Display mixed content – Enable or Prompt 
 Launching of programs and files in an IFRAME – Enable or Prompt 
 Navigate sub-frames across different domains – Enable or Prompt 
 Userdata persistence – Enable 
 Web sites in less privileged web content zone can navigate into this zone – 

Enable or Prompt 
 

o Scripting 
 (Required) Active Scripting – Enable or Prompt 
 Allow paste operations via script – Enable 
 Scripting of Java Applets – Enable 

 
4. Verify Advanced Browser Settings: Start > Control Panel > Internet Options > 

Advanced Tab 
 



 
RightNow Environmental Configuration Guide 

 
 

page 8 of 11 
 

o Browsing 
 Always send URLs as UTF-8 – Unchecked (International section for IE8) 
 Disable Script Debugging (IE) – Unchecked (when troubleshooting) 
 Display notification about every script error – Checked (when 

troubleshooting) 
 Enable third-party browser extensions – Checked 

 
o HTTP 1.1 Settings 

 Use HTTP 1.1 through proxy connections – Checked 
 

o Java (Sun) 
 Use Java 2 v 1.6.0_x for applet – Checked 

 
o Security 

 Use SSL 3.0 – Checked (for sites using SSL) 
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Installation Methodologies 
 
Web-based Installation: To use the most common installation methodology, an agent 
simply navigates to the appropriate URL, for example: 
  
 http://interface.custhelp.com/cgi-bin/interface.cfg/php/admin/launch.php 
 
Select ‘Install RightNow CRM’ on the launch page.  Note, once the application is installed, it 
is no longer necessary to navigate to the launch page.  Instead, RightNow CX can be started 
from the Windows Start menu.  The only time it is necessary to access the launch page is 
following an upgrade.  
 
Note that web based installation is based upon Microsoft ClickOnce technology. ClickOnce 
installation is precluded when a mandatory Windows profile is detected because ClickOnce 
utilizes the user profile as the installation file destination. 
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Network Troubleshooting 
 
Your networks should be proactively monitored to avoid false-positive reports of application 
issues. Even if your IT / IS staff are in another location, your staff should evaluate and check 
the state of corporate LAN/WAN/Internet connectivity before submitting incidents to 
RightNow's Technical Support team. This helps to ensure accuracy and efficiency when 
troubleshooting your issue. 
 
When requesting network troubleshooting assistance, please note the following guidelines: 
 
WAN / Internet Performance Information You or your IT/IS staff should generally be 
able to provide appropriate WAN / Internet troubleshooting and performance information. 
This includes information such as:  
 

 ICMP/UDP traceroute information from the affected call center to the associated 
RNT datacenter,  
 

 greater than 800-byte ICMP echo (ping) information from the affected call center to 
the associated RNT datacenter, and/or other more specific IP and Layer-4 session 
information related to reported issues. 
 

 
Network Topology: You should be able to provide a description of your network topology, 
such as single network, multi-site network with no connectivity, multi-site network with 
public [VPN] connectivity, multi-site network with private/dedicated connectivity. This 
description should include but not be limited to the following:  

 ISP(s),  
 circuit/access types (for both public and private network segments),  
 routing equipment vendor to ascertain configuration capabilities,  
 LAN/WAN utilization stats. Charts are preferred but the minimum, average, and 

maximum values for each circuit and location are acceptable statistics.  
 network appliances related to connectivity, such as firewalls, proxies, content filters, 

plus their configurations. 
 

Performance Monitoring Statistics: Basic LAN / WAN performance monitoring statistics 
should be available to analyze per site and per workstation issues. In addition, raw logs that 
provide information such as packet capture and network interface stats should also be 
available. Open source and multi-platform packages such as MRTG are inexpensive and easy 
to implement. 
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Workstation Troubleshooting 
 
When requesting workstation troubleshooting assistance, please note the following 
guidelines: 
 
Agent PC Configurations: You or your IT/IS staff should be prepared to discuss the state of 
agent PCs, including system components and resource utilization with tools such as 
Microsoft Perfmon. You should also be prepared to isolate individual agent workstations and 
network interfaces for comparison purposes in the event sporadic application performance 
conditions are present. 


